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1  INTRODUCTION AND CONCEPTS

INTRODUCTION TO ENCOMPASS

When we use the term “EnCompass,” we refer to two different things. The 
EnCompass technology is a database-centered software application which maps 
organizational processes and analyzes networks of communication and decision-
making within an organization. The EnCompass organization and service uses this 
technology to assist systems managers and corporate directors in understanding and 
improving business processes. Implicit in this effort are three related goals:

1. Analyzing and understanding the current state of affairs within the 
organization—where processes are working well, and where they need to be 
improved

2. Setting future goals and directions for change

3. Monitoring the pace and success of progress toward these goals

By combining the technological power of the software with the expertise of its staff 
and associated consultants, EnCompass offers custom-tailored solutions for clients in 
business, government, and education.

ORGANIZATIONAL PROCESS MAPPING

The company has gotten too big when, when you want to get 
something  done, you don’t know who to call. All you can do is to 
write a policy and hope that the right person knows that it was 
intended for him! 

— CEO, Fortune 100 Company

This quote typifies the sense of frustration increasingly experienced by senior execu-
tives and directors of complex and physically distributed organizations, as they 
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wrestle with the challenges of guiding their enterprises in a world characterized by an 
ever accelerating pace of change. The tasks of analyzing, synthesizing, and managing 
organizational processes and system infrastructure can be daunting ones. 

To meet this challenge, we need to understand how organizations actually work.

BASIC CONCEPTS

Task-related interactions

Axiom: Enterprises organize around tasks, not charts

Every organization has a defined structure, usually codified in a more-or-less formal 
organization chart which details its functional entities and their interrelationships. But 
in their day-to-day activities, people in an organization do not think about a chart; 
they interact with other people, and make decisions based on their perceptions of 
those people, their interrelationships, and their relative importance and impact on 
each other's work. When problems arise within an organization, it is usually because 
these perceptions do not match. But too often, management attempts to correct the 
situation by making mechanical adjustments to the “org chart”—reorganizing, re-
engineering, or downsizing—arrived at through depersonalized workflow methodol-
ogies that take no account of how personal interactions influence task execution and 
decision processes. Without the perspective of this “human” dimension, the picture is 
incomplete and provides only a partial foundation for the management of business 
processes, systems, and infrastructure. 

Thus, the tasks that make up the everyday heartbeat of any enterprise are carried out 
in a constant series of innumerable individual, personal interactions among its 
members—face-to-face meetings, phone calls, emails, and memos. And these interac-
tions take place not in isolation, but within a number of organizational networks of 
varying scope and complexity. Rather than simply altering the formal structure, it is 
crucially important to understand and strengthen the existing, functioning networks 
of personal interaction, and construct new ones in a planned and deliberate way.

Organizational networks

Within the enterprise, we can identify three types of organizational networks that 
provide the context for task-related interactions. These three types form a hierarchy 
of decreasing size and impact on organizational decision-making.

At the lowest tier of the hierarchy is the communication network, linking those who 
provide information with those who need to access it in the execution of their 
responsibilities. The next tier is the subset of those who have substantive influence on 
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the related processes or tasks. A still smaller set of individuals have a direct impact on 
decision-making processes.

Issues

As we examine this complex of organizational networks, a further layer of complexity 
arises from the fact that most organizations perform more than a single function. 
Almost always, they are involved in a broad range of different but interdependent 
tasks: R&D, product development, manufacturing, marketing, customer support, 
planning, corporate development, and so on. In any organization, members generally 
play different roles and exert different levels of influence within each of these 
functional areas. Therefore, the patterns of interaction among individuals and organi-
zational units—the networks of communication, influence, and decision—will vary 
widely depending on what function they are performing. Within the context of an 
EnCompass study, these varied tasks and business processes are referred to as issues, 
and for this reason we refer to the interpersonal interactions and the organizational 
networks as issue-dependent.

Expert knowledge

Axiom: Individual members are the experts

Another fundamental concept for understanding organizational processes is that 
individuals know the most about how their own jobs work: what is important and 
unimportant, and whom to talk to, and how, when tasks need to be accomplished. 
No one person is in possession of all this knowledge; rather, it is collective, 
distributed across the organization.

Closely related to this idea is the notion that when making decisions based on this 
individual, situational knowledge, people operate on perception, not fact. For 
example, it quite often happens that where one person perceives his or her interac-
tions with another to be crucial to their ability to perform a particular task, the other 
person attaches much less importance to them. In such a case, their attitudes and 
priorities during these interactions will differ markedly. Clearly, an organization where 
mismatches of this kind are common is one in which important processes are likely to 
be inefficient, or break down altogether.

As a corollary to this relativistic concept, we observe that for a manager who wishes 
to gain insight into how the enterprise works (or doesn’t), there is no single, objective 
or unbiased source of information. Every person within the organization has his or 
her own point of view—a view that is often further skewed by wishful thinking, self-
interest, or a natural desire to show one’s own performance in the best possible light. 
In fact, there are often as many perceptions as to how the enterprise functions, and 
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how it should function, as there are members of the organization. In order to create 
effective and enduring changes in group processes, it’s vital that these individual 
perceptions be melded into a consistent view of the current reality and a common 
vision for the future.

NETWORK MAPPING WITH ENCOMPASS

The EnCompass application is designed to address these concerns. For enterprise 
managers and corporate directors, it provides a tool for gathering information on 
individual task-related interactions throughout the organization, incorporating the 
differing perspectives of all its members. It produces visual maps of the multidimen-
sional and issue-dependent families and tiers of networks, enabling the analyst to 
examine these interrelationships to any desired level of detail, study the interplay 
between them, and locate ineffective, counterproductive, or missing processes. 
Careful study of the maps reveals graphical answers to a number of fundamental 
questions, for example:

Do the requisite communication channels exist to support informed decision 
and task execution processes? Who are the key people forming critical 
decision paths? 

Are the processes clearly understood, or are there significant misperceptions 
that could adversely affect current or future performance? Where are there 
underutilized human resources?

Are the right individuals involved and appropriately influencing the various 
decision processes, and are the links and networks through which decisions 
propagate through the organization appropriate?

Are there dysfunctional or irrelevant, resource-absorbing elements in the 
networks?

What factors influence the structure of these nonformal networks, and how 
can the networks be altered to align them better with the needs of the 
operation?

Measuring interactions—the data collection instrument

To collect and store all this information, EnCompass uses a data collection instrument 
(DCI), specifically tailored for each study (figure 1-1, page 5). Presented as a form 
which participants fill out either on paper or on the World Wide Web, the DCI lets 
each person in the study report on his or her regular task-related interactions with 
others in the organization. For each of these, the form records the name of the other 



ORGANIZATIONAL PROCESS MAPPING 5

ENCOMPASS KNOWLEDGE SYSTEMS 031215.1

person, the respondent’s perception of the interactions’ overall frequency and impor-
tance, and their usual modus of interaction—whether they are normally concurrent 
(face-to-face meetings, telephone, videoconference) or non-concurrent (email, fax, or 
memo). Factors such as interaction method have been shown to have a strong 
influence on the patterns of interaction.

Further, for each of the regular interactions, the DCI form asks the respondent to 
estimate its impact on both parties’ ability to get their jobs done, with respect to each 
of the tasks or processes that have been defined as issues for the specific study.

Displaying the data

Once the interaction data have been collected and entered into the EnCompass 
database (and the study project properly set up), the EnCompass application can 
display the interaction networks.

The EnCompass display starts with a 3D representation of the organization’s formal 
reporting structure (figure 1-2, page 6).

Here, each person in the organization is represented as a “node” in the hierarchical 
tree. The observer can show the structure to any number of levels, and rotate and 
zoom the display to look at it from any point of view.

The organization view
Although the 3D “org chart” is striking and interesting, by itself it provides little in the 
way of insight into organizational processes. The real utility of EnCompass begins 
when we display the results of the data-collection survey (figure 1-3, page 6).

Figure 1-1: EnCompass data collection instrument
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Figure 1-2: EnCompass 3-D Display

Figure 1-3: Data collection links
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Here, we see the same organizational structure as in figure 1-2, with the connecting 
lines removed so as not to clutter the display. Against this background, we overlay a 
pattern of bidirectional “links” between individual members of the organization. Each 
link—or more precisely, one-half of each link—represents a regular task-related inter-
action as reported by one person on one line of the data-collection form.

The color and thickness of each link show the importance and frequency of the inter-
action, as estimated by the respondent. Each link consists of two halves, each half 
representing the viewpoint of one of the parties to the interaction. For this reason, we 
describe the EnCompass-generated view as validated, meaning that each individual’s 
perception is subject to confirmation by the other.

Note that in many cases, the two half-links differ in color and width, indicating that 
the two parties did not agree on the frequency or importance of their interaction. In 
extreme cases, one half of a link is a dotted segment, indicating an “unconfirmed” 
link: one which was reported by only one person—the other party did not 
acknowledge that the interaction occurred at all. Clearly, a map that contains large 
numbers of disagreed or unconfirmed links (as here) is a picture of an organization in 
which communication is breaking down.

Typically, the EnCompass analyst generates a view like this one for each of the tasks 
or processes that have been defined as issues of concern for the study, or for combi-
nations of related issues. In each case, this organization view graphically shows 
where the important networks are located, quickly revealing isolated personnel, 
inefficient or inappropriate communications channels, and ineffective processes. 
Displaying the interaction networks against the organization structure aids the analyst 
in whether the formal structure supports or inhibits particular organizational 
processes.

By carefully selecting appropriate parameters for display, the analyst can focus on 
precisely those patterns of interaction that are of most concern. A study can include 
any number of analysis definitions that select and display subsets of interactions 
based on a number of potentially significant factors, such as:

The nature of the interactions themselves. For example, “high-frequency, low-
importance interactions” represent ineffective communication and wasted 
effort.

Characteristics of the people involved. Factors such as age, gender, location, 
salary, or tenure may have unintended effects on information flow or task 
execution.
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The level of agreement between the pairs of interaction partners. Links in 
which the two parties disagree strongly on their interaction’s frequency or 
importance signal areas of fundamental confusion about important processes.

For details on creating analyses and interpreting the results, see chapter 5. For illustra-
tions and discussion of example analyses, see chapter 9.

The issue view
In addition to the organization view, in which interaction links are displayed against 
the background of the organization’s formal structure, EnCompass also generates a 
set of issue views (figure 1-4). Here we reveal a different framework, one in which a 
person’s position depends not on his or her standing in the formal reporting 
hierarchy, but rather on the importance—as perceived by the other members of the 
organization—of his or her contribution to a specific issue or process. In this virtual 
hierarchy, an individual’s position may be quite different from the one he or she holds 
in the formal hierarchy, and will most likely vary from one issue to another.

The issue view thus provides a great deal of insight, by identifying those individuals 
who have real influence on decision-making about each specific issue. Further, by 
overlaying the interaction links against this framework, the analyst can see clearly the 
channels through which these decision-makers receive information and propagate 
their decisions throughout the organization.

Figure 1-4: Emergent structure—issue view



IN-PROCESS METRICS 9

ENCOMPASS KNOWLEDGE SYSTEMS 031215.1

“As-is” vs. “should-be”

The purpose of EnCompass is not only to analyze and understand the present 
situation. it’s also intended to help managers set future goals and directions for 
change, improvement, and alignment around key issues. 

In the first stage of an EnCompass study, the data-collection survey gathers infor-
mation from participants on their perceptions of the existing state of affairs within the 
organization. After these data are absorbed and analyzed, the same respondents are 
asked to complete a second survey. This time, they are asked to give their view of 
how things would work in the ideal organization. By tabulating these “should-be” 
results and comparing them with the original “as-is” picture, EnCompass reveals both 
existing channels that do not contribute to the desired goal, and a set of “missing 
links” that need to be put in place—in essence, a blueprint for creating the optimal 
organization.

By sharing and discussing these results with managers and key personnel, EnCompass 
consultants help the organization’s members arrive at a mutually agreed-upon vision 
for the future and a directed path to change. By periodically repeating the survey and 
taking new measurements, we monitor the enterprise’s progress toward its goals and 
provide the opportunity to make adjustments at key points in the process.

IN-PROCESS METRICS

The third goal of EnCompass is to enable managers to monitor the pace and success 
of their efforts toward change and process improvement. A primary tool for meeting 
this goal is the EnCompass enterprise metrics.

EnCompass metrics are a set of statistical calculations which measure the depth and 
quality of interrelationships among members of an organization. They enable the 
analyst to quantify organizational characteristics which in other settings are typically 
described in less precise and more impressionistic terms:

Clarity (or “alignment”): the overall level of agreement and understanding 
among the members of the organization or organizational unit.

Involvement: a measure of how effectively the organization's members are 
engaged in carrying out the tasks that are important to it.

Leverage: the degree to which the existence of an organization gives its 
members greater influence than they would have as independent individuals.

Priority: a measure of the perceived impact of the issues examined in an 
EnCompass study.
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Relative Priority: the impact of a single issue as compared to all the other 
issues.

Integration: the degree of interconnectedness between two organizations or 
organizational units.

Collectively, these results amount to a numeric “scorecard” of the degree to which 
an organization's communications and decision-making processes are integrated and 
effective. By tracking the numbers over time, metrics can serve as benchmarks for 
orienting and monitoring organizational change and improvement.

For more on metrics, see chapter 7.

ACTIVITY-BASED MANAGEMENT

In recent years, activity-based costing (ABC) systems have received increasing 
attention as a means of reducing costs and improving resource utilization in both the 
manufacturing and service sectors. By tracking the costs associated with organiza-
tional processes, ABC systems enable management to:

assess the true cost of products and services 

compute associated margins and profit contributions

improve competitive posture and enhance financial performance

By itself, however, ABC provides only the cost side of the picture. Traditional ABC 
methods provide no way of assessing whether the value derived from the individual 
activities warrants the cost incurred. 

INTRODUCTION TO ORGANALYST

OrgAnalyst is a component of the EnCompass software which completes the picture, 
by enabling not only costing, but activity-based management (ABM). By linking cost 
data with organizational process visualization, it provides managers with the infor-
mation they need to make sound management decisions, including:

identifying fragmented or ineffective use of resources

consolidating or reorganizing non-cost-effective processes
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Top-down vs. bottom-up costing

ABC systems typically calculate costs using a “top-down” approach, based on a 
defined hierarchy of organizational budget units. By tabulating the actual costs 
incurred within the various subunits, the system can tally up the total costs for each 
unit and for the enterprise as a whole. This approach is time-consuming, and can be 
difficult to implement throughout an organization.  Moreover, it lacks flexibility: for 
example, it makes it difficult to account for an activity that a person may perform in 
more than one department, and its inherent focus on products generally excludes 
other ways of calculating costs.

The OrgAnalyst model, in contrast, uses a “bottom-up” method. It starts with a 
comprehensive list of all tasks that members of the organization execute, for example 
“assembling equipment” or “analyzing safety reports.” OrgAnalyst tabulates the 
percentage of time each person spends on each defined task, and stores this 
“timeslice” data with the individual Person record in the database. By plotting it 
against salary data that is also part of the Person record, OrgAnalyst can make 
accurate calculations of costs down to the level of individual workers and activities.

Each task, moreover, can belong to a hierarchical set of tasks, called a work 
breakdown structure. Furthermore, the project designer can allocate each activity to 
one or more  programs, which can in turn form part of a program breakdown 
structure. Because these structures can be defined in any desired way, this approach 
provides for great flexibility. For example, the program structure is typically set up to 
match the organizational accounting structure, so that OrgAnalyst calculates costs as 
a function of budget unit. But it may equally well be defined in terms of functional 
areas, products, and so on.

Value-chain mapping

The most powerful advantage of OrgAnalyst appears when it is used in concert with 
EnCompass. By applying activity-cost data to the organizational process maps, 
OrgAnalyst can show the actual costs of interactions. As we have seen, the 
EnCompass process-visualization tools can map the value chain: the sequence of 
processes that add value to the product of the enterprise. By mapping its activity-cost 
data to each step in the chain, OrgAnalyst can reveal non-value-added steps and 
areas of inefficient or duplicated effort, and recognize opportunities for simplifying or 
consolidating processes and organizational structures. Finally, by constructing 
“should-be” views of the process, we can evaluate the potential savings of these alter-
native configurations.
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ORGANALYST STUDY RESULTS

The combination of ABC with process and interaction mapping methodologies has 
proven to be a powerful and cost effective method of identifying and localizing 
problems and facilitating change in under performing enterprises. In a recent case, 
the organization recovered six times the cost of the project in cost savings in the first 
year, and savings by the end of the second year aggregated to more than thirty times 
the total project cost. In addition, the organization exhibited positive cash flow and 
profit contribution for the first time in a number of years. Of potentially greater signif-
icance for the long term was a the halving of the product development cycle, a 
reduction in the cost of both new and existing products, and a substantial reduction 
in quality problems and warranty returns.

For a detailed discussion of OrgAnalyst and setting up ABM projects in EnCompass, 
see chapter 8.

ENCOMPASS PROCESS OVERVIEW

Because the organizations that use the EnCompass service may vary widely in size 
and needs, the exact steps in the process will differ from study to study. However, in 
most cases the procedure is organized around the following general outline:

1. Preliminary interviews—EnCompass staff (EnCompass personnel or associated 
consultants) meet with representatives of the organization to conduct an 
initial assessment of their needs and current status. EnCompass presents a 
formal proposal for approval. 

2. Definition of study issues and participants—EnCompass staff meet with 
organization team members to define the processes and issues to be 
examined and the population to be included. Based on this input, EnCompass 
constructs and tests a preliminary data collection instrument (DCI) to ensure 
that the issues are adequately defined and comprehensive, and that the survey 
population is sufficiently inclusive. 

3. Project setup—The designated project designer for the study creates a new 
project record in the EnCompass database, and sets up the project with the 
appropriate issues, attributes, selections, and display characteristics. 

4. Data collection—EnCompass makes the finalized DCI available on the World 
Wide Web. Data from the responses automatically enter the EnCompass 
database.

5. Data analysis—The analyst uses the EnCompass software to create analyses 
and examine the data, taking note of areas where mismatched perceptions 
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and inefficient communications channels may be creating problems for the 
organization. 

6. Facilitated workshops—EnCompass staff conduct two or three sessions for 
managers and other key personnel to review the analysis, discuss and 
negotiate differences that may be revealed, and examine alternatives for 
improving the effectiveness of the operation. 

7. “Should-be” survey—A second survey captures the organization’s collective 
view of its goals for the future. Analyzing the results of this survey provides 
maps which will serve as the organization’s “visual contract for change.”

8. Periodic updates—Regular status reviews monitor the organization’s progress 
toward its goals.

The EnCompass software provides tools to carry out the project setup and data 
analysis stages of the process, and may also be used to present results to the organi-
zational participants in the workshop stage. The tasks of conducting interviews, 
identifying issues, leading workshops, and presenting findings are performed by 
EnCompass personnel or consulting partners who are trained in the techniques of 
managing engagements. For a detailed discussion of the engagement process, see 
chapter 2. 

ABOUT THIS MANUAL

Throughout this book, we will generally observe the following typographical conven-
tions:

Italics, as usual, mean special emphasis on a word.

Terms you should remember are in boldface.

Terms that are explained in the glossary are in boldface and italic.

Names of windows, dialog boxes, data-entry fields, and similar interface 
elements are in italics, as are menu items.

Names of tabs and control buttons in EnCompass dialogs are also in boldface.

NOTE to readers of the draft version. The following color codes indicate conditional 
text to be included in the corresponding versions:

Basic

Advanced 

Engagement
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Working examples throughout the text are drawn mostly from the “Sample DB” 
project in EnCompass.

To submit questions or comments, please contact EnCompass:

By telephone: 310-231-2600

By fax: 310-231-2601

By postal mail: EnCompass Knowledge Systems, Inc.
11620 Wilshire Blvd., Suite 450
Los Angeles, CA 90025

By email: support@encompassknowledge.com

http://www.encompassknowledge.com
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3  USING THE SOFTWARE

GETTING STARTED

INSTALLATION

Load the EnCompass installation CD/ROM. The installation program should start 
automatically. If it doesn’t, execute the program SETUP.EXE in the root directory of the 
CD/ROM. Follow the installation program instructions.

LOGGING ON

Every EnCompass user is assigned a user name and password. You may use this 
name and password to log on to the system from your own workstation, or any other 
computer where EnCompass is installed. 

Start the program by double-clicking the “EnCompass” shortcut icon on your 
desktop (or click the Start button on the Windows task bar, and select 

Programs : EnCompass : EnCompass from the menu).

When EnCompass starts, it presents you with the Database Log-on dialog box 
(figure 3-1). To log on to the system:

1. In the Username box, type your EnCompass user name (if it’s not there already).

Figure 3-1: Database Log-on dialog
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2. In the Password box, type your EnCompass password.

NOTE: EnCompass user names and passwords are not case sensitive—that is, it 
makes no difference whether you type “password,” “PASSWORD,” or 
“PaSsWoRd.”

3. Click OK.

A small parasol symbol shows that EnCompass is making the connection with 
the database.

LOGGING OFF

To log off the system and exit EnCompass, do either of the following:

1. From the File menu, choose Exit.

2. Click the Close button at the upper right corner of the EnCompass window. 

CHANGING YOUR PASSWORD

Every EnCompass user logs in to the system with a user name and password. You can 
change your password whenever you wish.

To change your EnCompass password:

1. From the Administer menu, choose Change Password. 

2. Type your new password in the Password box. 

3. Press Tab to move to the Verify Password box, and type the new password 
again. 

4. Click OK to finish. You must use your new password the next time you log in. 

NOTE: EnCompass user names and passwords are NOt CaSe SEnSiTivE.

ENCOMPASS ONLINE HELP

From any dialog box within EnCompass, you can get specific 
help by pressing F1. To view the main Help page, choose 
Contents and Index from the EnCompass Help menu.
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THE TOOL BAR

The tool bar at the top of the Help window contains controls for navigation, printing, 
and other functions

.

Hide/Show toggles display of the navigation pane on and off. 

Locate locates the current topic within the table of contents. 

Back and Forward cycle through the topics you have already viewed. 

Home returns to the main page of the help system. 

Font cycles through the available display font sizes. 

Print provides printing options. 

Options provides access to a number of commands and the Internet Explorer 
Options screen. 

Using Help provides detailed information on using the online help system. 

THE NAVIGATION PANE

The navigation panel at the left provides four useful 
ways of locating individual help topics:

The Contents tab lists most topics in subject order. 

The Index tab lists topics in alphabetical order. 

The Search tab lets you search the entire help system for specific words or 
phrases. 

The Favorites tab provides a place to keep a personal list of frequently visited 
topics. 

To toggle display of the navigation pane on or off, click the Hide/Show button on the 
tool bar. 
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THE ENCOMPASS INTERFACE

ENCOMPASS DATABASE TABLES

EnCompass works by collecting data on the interactions between members of an 
organization, and storing all of this information in a database. As an EnCompass user, 
you can view and edit the details of any piece of this data, or extract any desired set 
of database records for analysis.

In order to retrieve information from the database, you must submit a query to 
locate the records containing the data you need.

SEARCHING THE DATABASE

All the information in the EnCompass database is organized in tables. Each table 
holds a specific kind of information, for example “locations,” “persons,” or “issues.” 
For descriptions of the EnCompass database tables, see Appendix A.

Within each table, the basic unit of organization is the record. Each record contains a 
number of fields, each one holding a single piece of data. You can open any record, 
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examine or edit the contents of its fields, and view its links to other records in the 
database.

NOTE: In many of the search fields, you must select a value from a drop-down 
list. The values you can choose from often depend on which project is selected. 
If appropriate choices don’t appear in the list, or some fields are disabled, click 
the General tab and make sure that the correct project is selected in the Project 
field.

4. Click Search. EnCompass searches the database for the information you 
requested, and displays the matching records in a data list window.

To retrieve records from the database, you need to know which table to 
search for them. The easiest way to see what database tables are 
available for searching is to look at the shortcut icons on the left-hand 
side of the EnCompass main window. (You can also access the tables by 
making choices from the File option on the EnCompass menu.) 

You tell the system exactly what information you want to retrieve by 
entering choices in a Search dialog box. This is called submitting a query 
to the database. (Technically, EnCompass converts the choices you enter 
in the Search dialog to SQL statements, which it uses to select records 
from the database.) You can create complex or highly specific queries by 
using wild cards in the search dialog fields, and you can save often used 
search patterns as named, stored queries and share them with other 
users.

To submit a database query:

1. On the vertical tool bar at the left-hand side of the EnCompass 
window, click the shortcut icon for the table you want to search. 
(Or choose the appropriate option from the File menu). 

2. In the Search dialog box, enter values in one or more search fields 
to limit the search. Use wild cards and numeric operators to save 
time and typing (see Using wild cards, page 34). 

3. Enter values in the search fields to specify conditions for your 
search. If the Search dialog contains more than one tab, you can 
enter values in individual fields to create a very specific query. 

To search for all the records in the current project, click Clear. To 
use a previously saved query, select a public or private search 
definition from the drop-down list at the top of the dialog box (see 
Using stored queries, page 35). 
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Using wild cards

A wild card is a single character that stands for one unspecified character, or a string 
of them. Two wild card characters are available for use in EnCompass: % and _.

The character % stands for any number of characters, either letters or numbers. It is 
equivalent to the familiar DOS/Windows wild card *.

For example, if you know that a person's last name is “Smith” and his first 
name begins with “J,” you can use “J%Smith” to find all names in the database 
that start with “J” and end with “Smith.” This search will also return “Jay 
Smith,” “Jed Smith,” and “Juliet E. Smith,” but it will find the record you want. 

The wild card symbol _ (the underscore character) stands for a single character, 
either a letter or a number. It is equivalent to the DOS/Windows value ?.

For example, if you cannot remember whether John spells his last name as 
Smith or Smyth, search for him by entering “John Sm_th.”

Example

To search for persons connected with the Acme Products Company (ACM) whose 
last names begin with the letter “C,” query the Person table as shown in figure 3-2 
(page 35). (Note the space before the letter C in the Name field.)

While the query is running, the icon in the upper right corner of the EnCompass 
desktop area changes to a moving one. The query is finished when the icon stops 
moving and once again indicates the data type you are working with. To stop a query 



THE ENCOMPASS INTERFACE 35

ENCOMPASS KNOWLEDGE SYSTEMS 031215.1

before it finishes, click the Stop button  on the tool bar (or choose Stop Query 
from the File menu).

USING STORED QUERIES

Most of the Search dialog boxes contain many fields, on multiple tabs. In order to 
make your database queries as specific as possible, you may often fill in a number of 
these fields with complex patterns of search values, including wild cards and numeric 
operators. For queries that you use repeatedly, you can save these search definitions 
and use them again later, so you don’t need to enter all the search criteria again. 
Stored queries appear in the search definition list at the top of each Search dialog 
box.

Figure 3-2: Database query (Search dialog)

TIP: Since the Acme Products Company (ACM) is the subject of the 
“Sample DB” project, you could obtain the same result by selecting 
Sample DB in the Project field, instead of ACM in the Label field.
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Stored queries can be public or private. Public queries are visible to any user; private 
ones are visible only to the person who created them. The Private and Public check 
boxes to the right of the search definition list box determine whether the list displays 
your private stored queries, all public stored queries, or both. (Note: Although public 
queries are visible to all users, they can be changed only by the person who created 
them.)

For example, to store the query we used in figure 3-2, we would take the following 
steps:

1.  In the Search Person dialog, click the Create New Query button on the tool 
bar.

2. In the Project field, select Sample DB. (If we wanted the query to apply across 
all projects, we could leave this field blank.)

3. In the Label field, enter “ACM,” the EnCompass database identifier for Acme 
Products. (We can look up the abbreviation in the Organization table.)

4. In the Name field, enter “% C%”. (Note the space before C; this ensures that the 
query will locate only last names.)

5. Click in the search definition list box to select the string “New Search 
Definition.” Type “Last name C.” 

6. On the tool bar, click the Save Query button to store the query definition. 

EnCompass stores the query with status Private. If we wanted to make it visible to all 
users, we would click the  icon to the left of the Search Definition box. The icon 
changes to , indicating that the query is now public. This means that it will appear 
on the list of available stored queries only when the Public box is checked. To change 
it back, click  again.

From now on, whenever we want to perform the same search again, we only need to 
open the Search Person dialog box, select the stored query from the list, and click 
Search. If the stored query doesn’t appear on the list, make sure that the appropriate 
Public or Private box is checked, and that you have selected the correct project in 
the Project field.

Using queries in analyses

Saved queries are especially important in creating analyses (see Creating Analysis 
Definitions, page 77). To build an analysis, you must tell EnCompass which sets of 
data-collection records to include; you do this by selecting from lists of named 
Criteria, Data Collection, Person, and Organization queries in the Analysis Data Entry 
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dialog. Each of these named queries must have been created and saved in its 
respective database table so that it will appear on the list.

LIST WINDOWS

When you click Search in a Search dialog, Encompass retrieves the information you 
requested and displays a list of the matching records in a data list window. A data list 
shows all the database records that match your search, one per line. The columns 
display information from selected fields in each record.

For example, the list in figure 3-3 displays the results of the search we specified in 
figure 3-2.

For each item in the list, the columns show the contents of selected fields in the 
corresponding database record. To see full details on any single item in the list, open 
the record to display it in a data-entry dialog box (see Data dialog boxes, page 41).

The View menu
The selection of which fields appear in a data list's columns depends on the view you 
select from the View menu. There is a “standard” view for each list, and EnCompass 
administrators may define additional views for each table as needed (see Creating 
view designs, page 187).

The Options menu
The Options menu presents some choices that are the same for all list windows, and 
some that are specific to individual lists.

Set DblClk determines what happens when you double-click an item in the 
list. For each list, you can select either Open Record, so that double-clicking 
opens the data entry dialog for that item, or another frequently used function. 

Figure 3-3: Data List window
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In most cases the second option is Start Query; this causes a double-click to 
display an exploded view of the selected record in the Tree View window. 

For the Analysis list, the second option is Load Analysis, which causes a 
double-click to load and run the selected analysis immediately. 

Minimize on Use—When the Set DblClk option is set to Start Query, check this 
option if you want EnCompass to minimize the list window when the query 
starts. 

Other options may appear for each list, usually to let you choose from a 
number of alternative list layouts. See the online help screen for each list for 
detailed information. 

Right-click menu
Every list has a context-sensitive menu, providing quick access to 
frequently used commands, including search, edit, select, explode, and 
print functions. To display the context-sensitive menu, click the right 
mouse button on any item in a list (or press Shift+F10 on the keyboard).

Help button

 For online help information about any list window, click the “Help on Lists” 
button on the EnCompass tool bar.

GENERATING LIST REPORTS

Besides viewing the details of records in a data list window, you can also create a 
report containing any or all of the records your search found. In this way, you can 
share information by transmitting data directly from the EnCompass database to your 
other offices or other people. You can send the report directly to a printer, attach it to 
an email message, or export it for use in a word processor, spreadsheet program, 
web browser, or other application. You can also preview the report before you send 
it. 

Previewing reports

Previewing reports from data lists lets you see on the screen how your report will 
look when printed.
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To preview a report of the list we created in figure 3-3: 

1. In the data list, select (highlight) the records you want to include in your report. 
(To select all the records, choose Select All from the Edit menu or the right-click 
menu.)

2. From the Reports menu, choose Print Preview Selected. 

Print preview window
The print preview replaces the data list, in the same window (figure 3-4).

The Preview tool bar contains buttons that let you scroll through the report, go 
directly to the first or last page, print the report, or export it to another program or 
disk file. (These commands are also available from the Preview menu.) The tool bar 
also contains a sizing box for enlarging or reducing the report image within the 
window.

 To print the report while you are in preview mode, click the printer icon on the 
Preview tool bar (or choose Print from the Preview menu or the right-click menu).

TIP: You can preview a report of all the items in the list (including those 
that were not included in your search) by choosing Print Preview All from 
the Reports menu or the right-click menu. 

Figure 3-4: Print Preview window
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To leave preview mode and return to the data list display, choose Close from the 
Preview menu or the right-click menu. (Note: Clicking the Close Window button will 
dismiss the list window completely.)

Printing search results

You can also print a report directly from the data list, without previewing it first.

To print directly from the data list:

1. In the data list, select (highlight) the records you want to include in your report. 

2. From the Reports menu, choose Print Selected. To print all the records in the 
list (including those that were not included in your search), choose Print All from 
the Reports menu.

EnCompass prints the report to your default system printer. To change printers or 
printer options, choose Print Setup from the File menu.

Sending search results by email

If your email software is properly set up, you can send an email message containing 
the results of your database query to anyone you wish.

To email search results:

1. In the data list, select (highlight) the records you want to include in your report. 

2.  Click the Email button on the tool bar, or choose Email Selected from the 
Reports menu. 

3. Fill in the addressee and subject information as your email program requests 
them. 

NOTE: Emailing reports only works if you have defined a Windows MAPI client. See 
the online help topic “Configuring your email program to work with EnCompass.”

Exporting data in other file formats

After you submit a database query and retrieve and sort the desired records in the list 
window, you can select any number of records from the list and export them for use 
in a word processor, spreadsheet program, web browser, or other application.
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To export data:

1. In the data list, select (highlight) the records you want to include in your report. 

2. From the Reports menu, choose Print Preview Selected. 

3. From the Preview menu, choose Export (or click the Export icon on the tool 
bar). 

4. In the Export dialog box (figure 3-5), click the 
arrow next to the Format box, and choose a 
format from the drop-down list. 

You can choose from various formats for 
spreadsheets, MS Word documents, PDF, 
HTML format for a web browser, and others. 

5. Click the arrow next to the Destination box, 
and select where you want the exported file to go. The destination can be a file 
on disk, an email program, or the registered application for files of this format. 
EnCompass will prompt you to make further choices depending on which 
option you choose. 

6. Click OK. 

To leave preview mode and return to the data list display, choose Close from the 
Preview menu, or from the right-click menu.

DATA DIALOG BOXES

To view full details of a single record in the list, you can open the record to display 
the information in a data-entry dialog box.

To open a data record:

While viewing a data list, do any of the following:

Double-click an entry in the list.

(NOTE: For this method to work, you must select Set DblClk : Open Record 
from the Options menu for this list.)

Right-click the entry you want to view, then choose Open from the pop-up 
menu.

Figure 3-5: Export dialog
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Select an entry by clicking it with the mouse, then choose Open Record from 
the Edit menu (keyboard shortcut Ctrl-E).

Select the entry with the Page Up/Page Down and ↑ / ↓ keys, then press 
Enter ↵.

For example, we can view the full database record for Charles Cunard by double-
clicking his name in the list in figure 3-3.  Figure 3-6 (page 42) shows the result.

Data dialogs usually contain several tabs, and allow you to modify the data in some 
fields.

 The New Record button on the dialog’s tool bar lets you create a new database 
record.

DISPLAYING DATABASE STRUCTURE

The EnCompass database is much more than simply a collection of records in 
unrelated tables. Each record has a place in a network of connections throughout the 
database. For example, a person is part of an organization, which exists at one or 

Figure 3-6: Data dialog box
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more specific locations. Within the organization, people supervise and report to one 
another in a hierarchy of authority and responsibility. These structured connections 
bring context and meaning to what would otherwise be only a mass of isolated facts.

The power of the EnCompass system lies in its ability to present this structure in a 
graphical display, which you can view from different angles and manipulate in various 
ways. This facility provides an important tool for visualizing the interrelationships 
between different kinds of data, and it is at the heart of the EnCompass method of 
analyzing patterns of interaction within an organization that is the subject of an 
EnCompass study.

However, to create this display, we have to start somewhere.

EXPLODING RECORDS

Once you have searched a database table and located a desired record in a data list, 
you can view its relationship to other records by a process known as exploding the 
record. You can explode down to see the record's connections with those below it in 
the database structure (its children and all their siblings), or explode up to see what 
higher-level structures it belongs to (its parents). EnCompass shows the exploded 
view in a Tree View window. In the tree display, you can select any item to see the 
details of that record.

For example, suppose we are working on the Sample DB project, and want to view 
the network of connections centered on the Acme Products Company’s COO, Don 
Vogel. We would proceed as follows:

1.  Click the Person icon on the vertical tool bar.

2. In the Search Person dialog box, select Sample DB in the Project field, and type 
“%Vogel” in the Name field.

3. Click Search to retrieve the record.

4. In the Person list, make sure Don Vogel’s name is selected.

5.  Click the Explode Down All button on the tool bar (or choose Explode 
Down All from the Search menu, or choose Explode : Down All from the right-
click menu).

EnCompass creates a tree display containing the record you selected and those that 
are connected to it.
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THE TREE DISPLAY

EnCompass can display structured data in two different ways:

The 2D (outline) display (figure 3-7) shows hierarchical relationships in top-to-
bottom order. 

The 3D (tree) display (figure 3-8, page 45) is a three-dimensional model which 
you can rotate, tilt, and zoom to get any desired perspective on the data. 

Each card in the 3D display, and each line in the 2D outline display, represents a 
single record in the database. You can toggle the display between 2D and 3D views, 
to take advantage of the most useful features of each view, by choosing 2D or 
Outline from the View menu or the right-click menu.

The status line at the top of the Tree View window shows the name of each record as 
you point to it (3D view) or select it (2D). For any selected record, you can do either 
of the following:

Double-click to open the record and see full details on it.

Figure 3-7: 2D (outline) tree display
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Click Explode Down or Explode Up again to redraw the display starting from 
that node.

Tree designs

Each card or outline item normally displays the name of the database record it repre-
sents. However, EnCompass administrators can create any number of alternative tree 
designs. A tree design is constructed from a set of tree views, each of which defines 
which data fields EnCompass will display for a given type of data—person, organi-
zation, data collection, and so on.

For example, the “standard view” shows the following data fields for person and 
organization records:

Figure 3-8: 3D tree display

2D 3D

Person ID, Name, Label Name

Organization ID, Label, Name, Phone, 
Web address

Name
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If needed, you could create an alternate design that shows the following fields 
instead:

Tree designs appear on the View menu in the Tree View window. To apply an 
alternate tree design, select it from the View menu, then click the Redo current 
query button at the top of the Tree View window to redraw the tree.

For details on creating tree views and tree designs, see chapter 10 and the 
EnCompass online help.

Status bar

When you select an item in either the 3D or outline display, the status bar at the top 
of the Tree View window immediately shows the following information about that 
record: 

Card: (Determined by the Card field in the corresponding tree view design) 

Id: The record's unique EnCompass system ID number 

Desc.: (Determined by the Description field in the corresponding tree view 
design) 

Type: The kind of data the record represents—i.e., the database table it resides 
in 

Changing the date and depth

When you “explode down all” on a data record, EnCompass can search the structure 
to a depth of 20 levels. In order to save time and simplify the display, you may want 
to restrict your query to a smaller number of levels. To limit the search to any desired 
depth, use the Levels control at the top of the Tree View window to select the 

number of levels you want to view, then click the Redo current query button.    

EnCompass remembers the value you enter here and uses it as the default for subse-
quent “explode down all” queries.

2D 3D

Person Title, Name, Department Title

Organization Name, Label, Type Name
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To see the state of database connections as they existed at a particular date in the 
past, clear the All check box at the top of the Tree View window and enter the date in 
the As of: field.

The Depth control (next to the Level control) works in conjunction with the “View 
nodes centric to a node” data-collection link control (see page 52).

Recent views list

When you explode a record, EnCompass remembers the starting point and the date 
settings you specified, and whether the view was up/down one or up/down all. (For 
up/down all views, it does not remember the number of levels.) You can see a list of 
the most recent views at the bottom of the File menu. To reload any of these views, 
click the item on the menu (or press its associated number key on the keyboard).

To remove all entries from the recent views list, choose Clear List from the File menu.

Building the structure

Of course, database structure doesn’t happen by itself. Any time you create a new 
record, you should be sure to create the appropriate connections between it and the 
existing structure. (This is especially important for the Organization, Person, Location, 
and Folder tables.) Records that are not connected to any others are orphans; you 
can locate them by using the Search … Orphans choice on the menu in each table. 
As the relationships between people and organizations change over time, you can 
easily make whatever changes are needed to maintain the structure and keep it up to 
date. For complete details on creating and maintaining database connections, see the 
online help topic “Managing database connections.”

Building a database structure is a necessary part of the process of setting up a project. 
For details, see Building Database Structure, page 74.

DATA DISPLAY CONTROLS

The graphical data display window is at the heart of EnCompass. The 3D and 2D tree 
displays let you visualize the connections among records in the database, and the 3D 
organization view and issue view are also the basis on which you overlay the results 
of data-collection analyses (see Displaying the organization view, page 85, Displaying 
the issue view, page 108).

In both the 3D and 2D views, EnCompass provides tools for manipulating the display 
in order to see the exact records and relationships you are looking for, and also to 
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tailor the appearance of every item in the display to your specifications. The display 
tools appear on the tool bar when the Tree View window is active (figure 3-9).

Showing and hiding data links

These top-level controls determine which sets of links appear in the display, and the 
direction and depth of exploded views. 

 Show data-collection links 

Shows or hides data-collection links, after you load an analysis. Turning this 
control on activates the data-collection link controls.

 Show hierarchy 

Shows or hides the organizational hierarchy structure. (Keyboard shortcut: Ctrl-L)

 Explode down/Explode down all 

Shows how a record is connected with those one or more levels below it.

 Explode up/Explode up all 

Shows how a record is connected with those one or more levels above it.

Showing and hiding data objects

When you explode a record, EnCompass displays the record and all those it is 
connected with in the database, in either a 2D outline or a 3D tree display, in which 
each record is represented as an individual card, and links between records appear 
as solid lines. The exact appearance of outline items, cards, and links (size, color, etc.) 
is controlled by settings on the Options menu.

In the 3D display, EnCompass adds a shaded pattern to the space that is shared by all 
the records that are one level apart. Each level thus appears as an umbrella-like cone, 
and multilevel structures are visible as nested sets of cones, making it easier to 
visualize the structure in a three-dimensional tree diagram which you can rotate, tilt, 
and view from any angle.

In a complex data structure, the display can be full of detail and difficult to read. 
EnCompass provides a number of functions to collapse or hide parts of the structure 
temporarily and make it easier to see the elements you need to view. To use these 

Figure 3-9: Data display tools



DISPLAYING DATABASE STRUCTURE 49

ENCOMPASS KNOWLEDGE SYSTEMS 031215.1

tools in the 3D display, select a cone by clicking one of the shaded umbrella lines, or 
the card that is at the vertex (top or bottom) of the cone, and then click one of the 
following buttons on the tool bar:

 Close all

Collapses the selected cone to take up less space.

 Open all

Reopens a collapsed cone to show all the cards.

 Simplify

Hides all objects except the selected cone.

 Complicate

Restores the objects that were removed by using the Simplify control.

 Detach cone

Removes the selected cone from the display completely. (This does not remove 
any connections from the database.)

 Attach cone

Restores the previously detached cone to the display.

NOTE: If you detach one cone and then detach another, the Attach cone function 
will restore only the second. The only way to reattach the first cone is to redraw 
the entire display with the “Redo current query” button.

TIP: Remember that the 2D outline display and the 3D tree display work 
together. The Close/Open and Simplify/Complicate tools work on the 2D 
display as well, and the actions you take in one view will affect the display in 
the other. For example, if you collapse a node in the 2D view and then 
switch to the 3D view, you’ll find that the corresponding cone is displayed in 
a collapsed state. Similarly, if you simplify a 3D view to display only a single 
cone, only the set of nodes belonging to that cone will appear in the 2D 
outline.
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Zooming, rotating, and navigating

So that you can view the data structure from any angle or distance, EnCompass 
provides tools for navigating around the display.

Controls on the tool bar:

 Zoom In/Zoom Out

Move your vantage point closer to or farther away from the structure. The zoom 
in and out step increments are set in the Display Settings dialog.

 Go to home setting 

Moves your vantage point back to the initial home view. The home view is 
defined in the Set Home View dialog.

 Make a U turn 

Returns to the previous vantage point.

 Rotate space to card 

Rotates the entire structure so that the selected card or cone is in front, keeping 
the same distance and elevation.

 Position view to card 

Rotates the entire structure so that the selected card or cone is in front, changing 
the distance and elevation as necessary.

 Rotate cone to card 

Rotates only the cone in which the selected card or cone is located so that the 
item is in front, leaving all other objects in place.

 Rotate cone counterclockwise/Rotate cone clockwise 

Rotates the selected cone counterclockwise or clockwise by 36 degrees. (Click a 
cone to select it.)
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Other controls:

Scroll bars

The scroll bars at the bottom and right-hand side of the Tree View window provide 
fine control over the vantage point. The horizontal scroll bar rotates the entire 
structure around the vertical axis. The vertical scroll bar controls the vantage point's 
elevation. Move the slider up to view the structure from more overhead, and down 
to view from a lower angle.

If the scroll bars are not visible, you can display them by choosing Scrollbars from the 
View menu.

Orbit 

The Orbit tool lets you move your viewpoint on the 3D data 
structure quickly to any desired angle. To display it, choose Orbit 
from the View menu.

To change your view of the structure, drag the red satellite dot to 
any position over the globe. To move to a position behind the 
globe, press the Ctrl key before releasing the mouse button. The 
dot turns yellow, and the vantage point moves to the rear of the 
globe.

To enlarge or move the orbit tool, double-click it. The tool display changes to a 
standard window that you can resize or reposition as necessary.

Sextant

The sextant provides a precise readout of your viewing 
angle and distance. it’s especially useful in conjunction with 
the orbit tool, for returning quickly to a specific viewpoint. 
To display the sextant, choose Sextant from the View 
menu.

The Latitude and Longitude figures indicate your vantage point's distance above or 
below and to the left or right of the center position, respectively. The Eye is at figure 
shows the altitude of your viewpoint above the surface, as controlled by the Zoom 
In/Zoom Out buttons on the tool bar.

TIP: When you move the vantage point below the center line (to view the 
structure from beneath), the table plane may obscure your view. To remove 
it, open the Environment Colors dialog, select the Table option button, and 
set Pattern to “None.”
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Data-collection link controls

When you use the tree view to display the results of an EnCompass analysis, two 
groups of controls determine the appearance of individual cards and the links 
between them. In addition, the Show menu provides options for displaying off-page 
links and lists of related data-collection records.

Displaying connected and unconnected nodes
These controls determine which sets of individual cards appear in the analysis display.

 View isolated nodes

Displays only those individuals who have no interactions matching the agreement 
parameters for the current analysis. Nodes that have any valid connections are 
removed from the display. This tool is a useful way to identify resources (people, 
departments, etc.) that are not well integrated into the organizational structure. 
(Keyboard access Show : Nodes : Isolated)

 View selected nodes

Shows the cards that are selected. This feature is useful for isolating and displaying 
the closeness path between two nodes. (Keyboard access Show : Nodes : 
Selected)

 View connected nodes

Displays only those individuals who have valid interactions matching the 
agreement parameters for the current analysis. Nodes that have no connections 
are removed from the display. (Keyboard access Show : Nodes : Linked)

 View all nodes

Shows all individuals whose names appear in data-collection records for the 
current project, whether they have links to other individuals or not. (Keyboard 
access Show : Nodes : Either)

Showing connections from a specific node
When you select any individual card in the display, these controls determine what 
links from it to other cards are visible. To select a card, move the mouse over the card 
until the legend at the top left of the Tree View window shows the correct name, then 
click once. (If the card you want is not readily visible, use the Search Item dialog to 
locate it; see Finding a card, page 53.)

 View nodes in network
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Shows all of a card's links to the network currently displayed. Use this to view a 
person's extended sphere of influence. (Keyboard access Show : Network : Node 
Network)

Clicking this button again returns to the “view network” mode. 

 View nodes centric to a node

Shows the direct links from the selected card. Use this to see an individual's 
immediate sphere of influence. (Keyboard access Show : Network : Node Centric)

To view links from a different node, click this button again to return to “view 
network” mode, then select the new card you want to focus on and click this 
button again.

Remember to set the link depth to a high enough value to include all the links you 
want to see. To change the node-centric depth, choose a new value with the 
Depth control, then click this button twice to redraw the display.

 View network

Shows the entire network of links among all cards on the display. (Keyboard 
access Show : Network : All)

NOTE: Remember that EnCompass displays links based on the specific analysis 
you have loaded. A person may have interactions that don’t appear on the display 
because they are not relevant to the issues selected for the current analysis. To 
see the full set of interaction links, create or load an analysis that includes all 
issues. 

Off-page links
In the tree display, you always have the option of choosing the number of 
hierarchy levels you want to display. Limiting the depth of the view will simplify 
the display and make it easier to navigate. However, links to cards at lower levels 
will appear to be dead ends, because those cards don’t appear anywhere on the 
screen. Normally, EnCompass doesn’t show these dead-end links. If you want to 
see them, check Offpage Links on the Show menu.

FINDING A CARD

In a large or complex 2D or 3D tree display, it may be difficult to locate a specific 
card simply by a visual scan. In this case, you can locate a card quickly by using the 
Search Item function.
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To find a card in the tree display:

1. From the Edit menu, choose Search Item (keyboard shortcut: Ctrl-F). 

2. In the Search Item dialog 
(figure 3-10), enter values in 
the Card, Description, or 
Outline Text fields to specify 
the card you want to find. 

The “=” option button searches 
for exact text. The “Like” option looks for any card containing the string you 
enter, and accepts the % wild card. All searches are case-insensitive. 

3. Click Search. 

EnCompass automatically selects the first card it finds that matches your search text. 
To look for another matching card, choose Search Next Item from the Edit menu 
(Ctrl-N).

SHOWING DUPLICATE NODES

The Show Duplicate Nodes function lets you isolate quickly any objects that appear 
more than once in the tree display.

To view duplicate nodes in the tree:

1. Display a data structure in the 2D outline or 3D tree view. To find duplicates in 
a multi-issue tree, explode down on a master or meta issue. 

When you want to make a list of duplicate names, it’s easier to view it in the 2D 
outline view. 

2. From the Show menu, choose Duplicate Nodes. EnCompass highlights all 
objects that appear more than once. 

3. On the main tool bar, click View selected nodes. 

The “show duplicates” feature is especially useful when examining multiple-issue 
analyses, where it’s often important to verify that related issues are well integrated. 
For example, the same decision-makers may need to be involved in both product 
design and cost planning. Conversely, in other cases it may be advisable to ensure 
that the same individuals do not play a role in areas that should remain separate, such 
as corporate auditing and investment management.

Figure 3-10: Search Item 
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CUSTOMIZING DISPLAY SETTINGS

The following settings, available through the Options menu, apply to the display on 
the local workstation; they don’t affect other users. In most cases, you can change 
these settings for a single session, or save them for future sessions.

Other display settings are global and apply to all users. Normally, the project designer 
defines these settings when setting up each project.

As Of options

When exploding a record, EnCompass normally searches the database for all connec-
tions that existed at any date. To limit all your searches to only those database 
connections which existed as of a particular date, choose As Of from the Options 
menu. On the Date panel, select the As Of option and enter a date in the adjoining 
box.

Dialog field colors

This feature is only for use in product development. It is not functional in normal use.

Display codes (2D view)

In the 2D outline view, EnCompass can display a 
sequential number for each record, indicating its position 
in the current structure; e.g. 1.1.1, 1.1.2, and so on for 
records at the third level. To show these numbers, check 
Display Codes on the Options menu.

Display settings (3D view)

The Display Settings dialog (figure 3-11) controls basic size and zoom-factor settings 
for the 3D graphic display. 

To open the Display Settings dialog, choose Display Settings from the Options menu.
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Focal Length: focal length of a lens 
viewing the structure. Lower values are 
wide-angle views; higher values are 
longer, “telephoto” views. 

Zoom In Rate/Zoom Out Rate: rate at 
which the Zoom In and Zoom Out tools 
move closer to or further away from the 
structure 

Parasol Open Factor/Parasol Closed 
Factor: width of a hierarchy cone when 
opened and closed (relative to the default values) 

Parasol Height Factor: displayed height of a hierarchy cone (relative to the 
default value) 

To return the display settings to the system defaults, click Defaults.

To use the new settings only for the current session, click OK. To save the new 
settings for all future sessions, click Save. Changes you make to the display settings 
apply only to the local workstation; they don’t affect other users.

Tree View Environment (2D view)

The Tree View Environment dialog (figure 3-12, page 56) lets you set the background 
color for the 2D tree display. It also contains the Font button, for changing the font 
that appears on items in the 2D tree display.

To display the Tree View Environment 
dialog, choose Environment Color from the 
Options menu.

To choose a background color, make a 
selection from the Color of Background 
chart. The Outline Sample box shows what 
the display will look like with your current 
color and font settings. (To change the 
font, click Font and make your selections 
in the Environment Font dialog.) Click 
Apply to apply the changes to the display.

To restore the system defaults for color and font, click Default. To save the current 
settings so that they will be used for future sessions, click Save. 

Figure 3-11: Display Settings dialog

Figure 3-12: Tree View Environment dialog
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Environment colors (3D view)

The Environment Colors dialog (figure 3-13) lets you customize the appearance of 
various elements in the 3D view, such as the background, the connecting lines and 
covering surfaces of cones, and the horizontal plane. 

To display the Environment Colors dialog, choose Environment Colors from the 
Options menu.

To change the background color:

1. In the Color of box, select Background. 

2. Click a color in the chart to select it. 
The Sample box shows how your 
selection will look. 

For presentation purposes, you may 
want to select a white background. 

To change the appearance of connecting 
lines

1. In the For Hierarchy Level field, select 
the number of the hierarchy level you 
want to customize. “0” controls the 
top-level cone. 

2. In the Color of box, select Connectors. 

3. In the Color when box, choose Selected to set colors for links at this level when 
they are selected; choose Not Selected to set colors for links when they are not 
selected. 

4. Click a color in the chart to select it. The Sample box shows how your selection 
will look. 

To change the cone covering

1. In the For Hierarchy Level field, select the number of the hierarchy level you 
want to customize. “0” controls the top-level cone. 

2. In the Color of box, select Covering. 

3. In the Color when box, choose Selected to set the appearance of cones at this 
level when they are selected; choose Not Selected to set the appearance of 
cones that are not selected. 

Figure 3-13: Environment Colors dialog
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4. In the Pattern box, choose a pattern (texture) for the cone surfaces at this level. 
To make the cones transparent, click “None.” 

5. Click a color in the color chart. The Sample box shows how your selection will 
look. 

To change the horizontal table

1. In the Color of box, select Table. 

2. In the Pattern box, select a pattern (texture). To make the table transparent, 
click “None.” 

3. Click a color in the chart to select it. The Sample box shows how your selection 
will look. 

When choosing a pattern for the covering and horizontal table, note that some 
of the patterns are transparent, so that the objects are visible through them, 
whereas others are opaque and block your view of any objects behind them.

Applying and saving your settings:
To apply your settings to the current session only, click Apply. To save them for all 
your future sessions, click Save. To restore all the system default settings, click 
Defaults. 

Environment font

The Environment Font dialog 
(figure 3-14) lets you choose 
the font, size, and style of the 
lettering on individual items 
in the tree display—cards in 
the 3D display, and line items 
in the outline display.

To display the Environment 
Font dialog:

From the 3D view, 
choose Environment Font 
from the Options menu. 

From the 2D view, choose Environment Color from the Options menu, then in 
the Tree View Environment dialog, click Font. 

Figure 3-14: Environment Font dialog
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To use the Environment Font dialog, select values for Font Name, Size, and Type 
Style. The Font Sample box shows how your choice will appear on the screen. To 
restore the system default values, click Default.

Click Apply to apply your settings to the current display.

To save the setting so it applies to future sessions:

For the 3D view, click Save. 

For the 2D view, click Apply, then click Save in the Tree View Environment 
dialog.

Indent (2D view)

Normally, in the 2D outline view, EnCompass indicates each new 
hierarchy level by indenting the line. To remove the indenting and 
make all lines start at the same point, clear the Indent option on the 
Options menu.

Set home view (3D view)

The Set Home View dialog (figure 3-15, page 59) determines your initial vantage 
point on the 3D data structure when you first display the tree view. You can use the 
Home button on the tool bar to return to this viewpoint at any time.

To display the Set Home View dialog, choose Home from the Options menu.

Latitude controls the observer's angle above 
or below the equator, in degrees. 

Longitude determines the position around the 
globe. 

Home Eye Point gives the observer's distance 
from the globe, as a percentage of the default 
value. 

To make the home values equal to those currently active in the display, click Current. 
To return the home values to the system defaults, click Defaults.

To use the new home values only for the current session, click OK. To save the new 
values for all future sessions, click Save. Changes you make to the home settings 
apply only to the local workstation; they don’t affect other users.

Figure 3-15: Set Home View dialog



60 ENCOMPASS ADVANCED TRAINING—3

031215.1 ENCOMPASS KNOWLEDGE SYSTEMS

Size cards (3D view)

The standard size for cards in the 3D display is set by the Object Design specifica-
tions for each project. You can enlarge cards to see the text on them more easily, or 
reduce them to get a clearer view of the connecting links.

To enlarge or reduce cards from the default size, choose Size Cards from the Options 
menu and choose a percentage value from the list. This value remains in effect for all 
3D views until you change it.
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10  ENCOMPASS ADMINISTRATION

n addition to the commonly used basic program features and the search and data-
entry functions available through the individual database tables, there are a 
number of administrative tasks which EnCompass users occasionally need to 

perform. Access to most of these activities is restricted to users with Administrator or 
Operator privileges.

ADDING A NEW USER

Every person who will log in to EnCompass must have an entry in the User table of 
the database, which contains the user name, password, user type, and other access 
options. You may add a new EnCompass user at any time. However, note that 
because every user record must be connected with a record in the Person table, you 
must first make sure that the person record exists before creating a new user.

To add a new user:

1.  Search the Person table for the person you want to add as an EnCompass 
user. If the person is not listed, create a new record for him or her in the Person 
table. When finished, click Save and Close, but don’t close the Person List 
window yet. 

2. Open the User Profile list by running a database query on the User Profile table. 
Since the purpose of this query is only to open the list window, you may stop it 
at any time (or search on the name of a nonexistent user like “x”). 

3. Right-click anywhere in the User Profile list, then choose Create New Record 
from the popup menu (or choose Create New Record from the Edit menu). 

4. In the General tab of the User Profile–Data Entry dialog, enter the appropriate 
information in the data fields. For help on filling in a field, select the field and 
press F1. 

I
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NOTE: It’s especially important to make sure that the “initial password” 
information is correctly entered in the Description field. If this is not done, the 
database will fail to recognize the user.

5. Click the Person tab. In the Person list, select the person record for your new 
user. Press and hold the right mouse button, drag the person record to the User 
Profile–Data Entry dialog, and drop it there. EnCompass fills in the data fields 
with information from the Person record, and creates the appropriate database 
connections. 

6. Click Save and Close to finish creating the new user record. 

When you create a new user account, it’s always a good idea to log on using the new 
user’s ID and password, to ensure that the record was created correctly. Then send 
an email to the new user informing him or her of the creation of the new account and 
the password.

CREATING A NEW GLOBAL SELECTION

Global selections are the records that determine what choices appear on drop-down 
lists in data-entry and search dialogs throughout EnCompass. (These are system-wide 
choices, such as organization types or project types. Settings which change from 
project to project are set in the Project Selections table.) Once the choices for a 
given dialog field are set up, there is generally little reason to change them. However, 
you can create new items when needed.

To create a new global selection:

1. Search the Global Selection table for any or all existing selection types. 

2. In the Global Selection List, click the New Record button on the tool bar (or 
choose Create New Record from the Edit menu or the right-click menu). 

3. In the Global Selection Data Entry dialog, fill in the data fields with information 
to identify the selection item. 

4. When finished, click Save and Close. 

For a list of the global selections that are available, see the Reference and Lists 
section of the EnCompass online help.

For information on other administrative tasks—for example, testing database and 
server connections—see the topic EnCompass administration in the EnCompass 
online help.
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CREATING VIEW DESIGNS

Views define what data fields EnCompass will include when displaying database 
records in either a data list or the 2D or 3D tree display. There are two kinds of view:

List views apply to data list windows. They determine which database fields 
appear in the columns, as well as the column header names, default sort 
order, and grouping properties. List views appear on the View menu of a data 
list. 

Tree views are the building blocks of the tree designs which are available in 
the graphical tree display. For each type of data (person, organization, etc.), a 
tree view can control which fields appear on the cards in the 3D display, in the 
columns of the 2D (outline) display, and in the status line in both display 
types. 

Views are stored as records in the View  table, and EnCompass administrators create 
them using the View Design Data Entry dialog box.

To create a new view:

1. Search the View table for views of the type you intend to create: List or Tree. 

2. In the View list, click the New Record button on the tool bar (or choose Create 
New Record from the Edit menu or the right-click menu). 

3. On the General tab of the View Design Data Entry dialog, fill in the data fields 
with information to identify the view. 

To copy an existing view, use the right mouse button to drag an entry from the 
View Design list. 

4. On the Column Layout tab, select the columns you want to appear in this view. 
To add a column, select an entry in the Available Fields panel and click Add. 
Repeat until all the fields you want appear in the Column Assignments panel. 

For details on the other fields on this tab, consult the context-sensitive help for 
each field (Shift-F1). 

5. If you are creating a list view, go to step 7. If you are creating a tree view, click 
the Tree View tab. Select which database fields you want to appear in the Card 
and Description fields in the tree display. 

6. If you want this tree view to include a specific object design for data from this 
table, select the field that the Object Design table should refer to in the Design 
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Column field. For each card, EnCompass compares the data in the field you 
specify here with that in the Label field of the Object Design table. If the values 
match, EnCompass uses the specified card design to display the card. 

Example

For the Person table, the tree view called "Division" specifies the Division field as 
the "column used for design type." If we turn to the "Sample DB" project and 
examine the person records for J. Ball (president) and D. Vogel (COO), for 
instance, we see that both of them are in the "Executive" division. If we now 
look at the Object Design List, we see that for entries with the label "Executive," 
it specifies a fat oval with a red background. Therefore, any layout that uses the 
"Person – Division" tree view will draw the cards for J. Ball and D. Vogel with 
that design. 

By contrast, any layout that uses the "Person – Standard" tree view will apply no 
special design to the cards for J. Ball or D. Vogel, because that view specifies the 
Corptitle field as the "column used for design type," and the Object Design List 
contains no entry for "President" or "COO." 

7. When finished, click Save and Close. 

8. From the Administer menu, choose Setup : Clear Cache.… 

If you created a list view, the new view should now appear on the View menu in the 
data list window. If it’s a tree view, the new view should now appear in the Available 
Views list in the Tree Design Data Entry dialog.

CREATING TREE DESIGNS

Tree designs let you customize the appearance of the graphical tree display in 
EnCompass. A tree design consists of a set of tree views, which determine what data 
fields appear in the display for each type of data (person, organization, etc.). By 
picking and choosing from among the available tree views, you can build a tree 
design that shows exactly the information you want to see for each data type. The 
available tree designs appear on the View menu in the 2D and 3D tree displays. 

To create a new tree design:

1. Search the Tree Design table for any or all existing tree designs. 

2. In the Tree Design list, click the New Record button on the tool bar (or choose 
Create New Record from the Edit menu or the right-click menu). 
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3. In the Tree Design Data Entry dialog, fill in the data fields with information to 
identify the design. 

To copy an existing design, use the right mouse button to drag an entry from 
the Tree Design list. For detailed information on any field, consult the context-
sensitive help (Shift-F1). 

4. When finished, click Save and Close.

BACKING UP THE REGISTRY

Occasionally, after an abnormal program exit, some EnCompass functions that 
require access to the database may stop working properly. Often this problem is 
caused by a corruption of entries in the user’s local Windows registry, and in this case 
the easiest way to restore normal function is to overwrite the corrupted registry key 
with a previously saved backup.

To save a backup copy of the EnCompass registry key:

1. From the Windows Start menu, choose Run.

2. In the Run dialog, type “regedit,” then click OK.

3. Locate and select the key named 
“HKEY_CURRENT_USER\Software\Parasol\Encompass.”

4. From the Registry menu, choose Export Registry File.

5. In the Export Registry File dialog box, choose the location and file name for the 
saved backup and click Save. Windows saves the file with the extension .REG.

To restore the saved registry key:

1. Use Windows Explorer to locate the .REG file you saved.

2. Right-click the file name and choose Merge from the pop-up menu.
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GLOSSARY

activity

A defined task assigned to personnel in an activity-based management system.

analysis

The output stage of the EnCompass process. Each analysis query displays the inter-
action patterns of a particular set of study participants, reflecting a specific combi-
nation of issues, attributes, and agreement criteria.

as-is

A set of data-collection records which reflect the current state of affairs within an 
organization. Contrasts with Should-be, a type of data-collection record that records 
the ideal situation.

attribute

A characteristic of a person or an organization that is likely to have an influence on 
interactions between people, for example “salary grade,” “company tenure,” or 
“number of employees.”

card

The representation of a database object in the 3D tree display. Card shapes, colors, 
and sizes are determined by settings in the Object Design table.

child

A record that comes below another record in the database structure hierarchy. A 
record may have one or more children.
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concurrent

Occurring while both parties to an interaction are available and participate at the 
same time through a direct medium of communication, as in face-to-face discussions, 
meetings, telephone conversations, or video conference.

confirmed link

A data-collection link that is reported by survey respondents on both sides: A 
interacts with B, and B interacts with A. The two respondents may report different 
values for frequency, importance, and impact.

criteria

Defines a database query that will select data-collection records for an analysis. For 
each of the issues in a project, it specifies a range within which the interaction values 
reported by the From person and the To person must match, in order for the data-
collection record to be included in the analysis.

data collection

The records of all the individual interactions between members of an organization in 
an EnCompass study, as gathered by the study's survey questionnaire.

data collection instrument

A survey form, either on paper or web-based, through which each study participant 
reports the frequency, importance, and impact of his or her interactions with other 
organization members.

database

A method of storing data in a computer in an organized, logically connected fashion. 
Information in a database is organized in tables, records, and fields.

duration

The average length of a person's typical interaction with another person regarding a 
specific issue.

effectivity date

The date when a connection in the data structure is visible in the display. A 
connection that is in-effective appears in the tree display, with its connected records. 
A connection marked out-effective for a given date disappears when the display is set 
for that date or after.
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emergent structure

A structure that is based not on the formal organizational hierarchy, but rather on the 
importance that individual members assign to each other. Emergence can reveal who 
are the truly active figures in an organization, against a scale of real impact on 
specific issues, and irrespective of corporate seniority.

field

A single distinct element of a record in a database, consisting of a single piece of 
information of a specific type.

filter

[under construction]

folder

A container element that serves to organize database records.

frequency

A measure of how often one person interacts with another.

global selection

Determines the system-wide choices that appear in drop-down lists in EnCompass 
dialogs, such as organization types and project types, subtypes, and statuses.

impact

A measure of how great an effect a person's interaction with others has on the 
individual issues defined for a project.

importance

A study participant's perception of how important an interaction is to successfully 
completing his or her work tasks.

issue

One of the matters of central concern and importance for the purposes of an organi-
zational analysis. Issues typically involve business processes such as “market 
planning” or “customer communication.”
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issue view

A view of EnCompass study data in which the network of individual interactions 
appears against an emergent structure based on each individual's importance to a 
specific issue.

job

An automated task that EnCompass performs. This includes events that occur at 
regular intervals, such as time announcements, as well as database-record updates 
which are waiting for processor time to become available.

link design

The color and width settings used to display data-collection links in the 3D tree 
display.

list view

A database record that determines which database fields appear in the columns of a 
data list. The available views appear on the View menu for each table.

nomination

The number of survey respondents who must assign a given impact value to their 
interactions with a person on an issue for that person to rise to a given level in the 
emergent structure. For example, if the nomination level in an analysis is set to 10, 
person B will be promoted to level 5 if and only if at least 10 other people assign an 
impact value of 5 to their interactions with person B. People who fail to receive the 
specified number of nominations at any level appear at level 0. The number of 
required nominations is set in the emergence analysis definition.

nonconcurrent

Occurring when two parties to an interaction do not participate simultaneously and  
the interaction involves an indirect medium of communication, such as paper 
documents, faxes, or email.

object design

Specifications for the color, size, shape, and font of objects displayed in the Tree 
View window.

organization view

A view of EnCompass study data in which the network of individual interactions 
appears against the organization's formal reporting structure.
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parent

A record that comes above others in the database structure. Any record can have 
only one parent.

program

An administrative unit to which individual activities are assigned in an activity-based 
management project.

project

The large-scale unit of organization for work in EnCompass, typically involving the 
analysis of interactions among members of a single company or other organization.

project selection

Defines the values that data fields can have within a project—the choices that appear 
in the drop-down lists for many fields in the Attribute, Person, Organization, and 
other data-entry dialog boxes.

real-time server

The computer that handles EnCompass system events, including user logins, records 
created or changed, and messages sent between users. Real-time event messages 
appear in the Real-Time Messaging List.

record

A collection of data or words treated as a unit in a database. The individual elements 
of data in each record are stored in fields, and the records in turn are organized in 
tables.

revision history

A list of the revision records that are attatched to a database record. A revision 
record is added each time a change is made to a record's connections to other 
records in the database, and includes the effective date, change-order number, 
revision level, and other revision-tracking data.

revision record

A database record containing detailed information on changes to a single database 
object. Revision records are listed in the revision history for each object.
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should-be

A set of data-collection records which reflect an organization's ideal structure. 
Contrasts with As-is, a type of data-collection record that records the current state of 
affairs.

sibling

A record that is at the same level as another record in the database structure. Sibling 
records share the same parent, but cannot share any of the same children.

table

The portion of a database that contains a specific type of data. Tables contain 
records, which in turn hold specific elements or fields. You can search database 
tables in EnCompass by using the Search shortcut icons on the vertical tool bar at the 
left of the screen.

timeslice

In an activity-based management (ABM) project , the percentage of time that an 
individual spends on a given activity.

tree design

A database record that defines which data fields will appear in the EnCompass 
graphical 2D or 3D tree display. A tree design consists of a collection of tree view 
definitions, one for each data type.

tree display

The two- or three-dimensional display of the hierarchical relationships between 
objects in the EnCompass database. Includes both the Organization view and the 
Issue view.

tree view

A database record that determines which database fields appear in the 2D and 3D 
tree displays of records from a given table. A collection of tree views for all tables 
makes up a tree design.

user

A person who is authorized to log in to the EnCompass system. Information on 
EnCompass users appears in the User Profile table.
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wild card

A character that substitutes for and allows a match with any character or set of 
characters in its place. Many software programs use symbols such as * and ? as wild 
cards. EnCompass uses % and _.
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APPENDIX A:
ENCOMPASS DATABASE TABLES

The EnCompass database contains the following tables. NOTE: Not all tables are 
visible to all EnCompass user types.

Activity

Activity records contain the names of individual tasks assigned to people in an 
activity-based management (ABM) project.

Analysis

Stores analysis definitions, which are built up from stored queries in the Criteria, Data 
Collection, Person, and Organization tables. Each analysis query displays the inter-
action patterns of a particular set of study participants, reflecting a specific combi-
nation of issues, attributes, and agreement criteria.

Attribute

The list of personal and organizational attributes for each project. Attributes are 
characteristics of people or organizations that are likely to have an influence on inter-
actions between people, for example “salary level,” “company tenure,” or “number 
of employees.” The EnCompass analyst can study these effects by using person or 
organization queries to select for specific attributes.

Criteria

Criteria queries are used in analysis definitions. A criteria query specifies a range 
within which the interaction values reported by the “From” person and the “To” 
person must match, in order for the data-collection record to be included in the 
analysis. Every analysis must include a Criteria query.
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Data Collection

Records of all the individual interactions between members of an organization in an 
EnCompass study, as gathered by the study's survey questionnaire. Each data-
collection record contains the rankings that a specific person gave to his or her inter-
action with one other person, in terms of its overall frequency, importance, and 
impact on each of the issues that the project designer has defined as important.

Document

Documents and forms available to all EnCompass users.

Filter

Not used.

Folder

Folders are container elements which users may add in order to organize connec-
tions among database records.

Formula

Table formulas are calculations that EnCompass can perform on numerical fields in 
database records. Once the EnCompass engineering team creates a formula, it 
becomes available for use in list views and tree views, so that its results can appear in 
data lists and tree displays.

Global Selection

Global selections determine the system-wide choices that appear in drop-down lists 
in EnCompass data-entry and search dialogs, such as organization types and project 
types, subtypes, and statuses.

Issue

Basic identifying information on the defined issues for each project.

Job Schedule

A list of all the automated tasks that EnCompass performs. This includes events that 
occur at regular intervals, such as time announcements, as well as pending database-
record updates awaiting processor time.

Link Design

Color and width settings for the display of data-collection links in the 3D tree display.
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Location

A location is any place where an organization in the EnCompass system has a 
business presence. Locations can be as general as world regions (for example, “North 
America”), or as specific as a street address. The more specific locations contain full 
address information (street address, postal code, etc.), while more general locations 
contain only the identifying name and corresponding code.

Message Log

A detailed record of analysis transactions. When you perform an analysis on records 
in the database, the message log remembers the individual steps it took to complete 
the analysis.

Object Design

Specifications for the display of objects in the Tree View window. For the 2D outline 
view, object design specifies the font, color, and size of each type of item. For the 3D 
view, it controls these characteristics as well as the color, shape, and size of cards.

Organization

Information on companies that provide services to EnCompass—consultants, vendors, 
and the like—or that participate in EnCompass studies.

Person

Names, addresses, and contact information for people who take part in EnCompass 
activities, either by providing services to EnCompass, or by being participants in an 
organizational study.

Program

Programs are administrative units to which individual activities are assigned, in the 
context of an activity-based management project. A program record can be either of 
two types:

Program units are the specific organizational entities that hold the 
responsibility for individual work units. Each work unit must be attached to at 
least one program unit. 

A program branch is a container object which provides a structure for the 
individual program units. Program branches normally consist of higher-level 
organizational groups, for example [good examples needed]. 
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Together, program units and program branches constitute a program breakdown 
structure for each ABM project: a hierarchy within which each activity for each 
person finds a place.

Project

Basic identifying and descriptive information on each EnCompass project.

Project Selection

Project selections define the values that data fields can have within a project. In 
practice, this means that project selections determine what choices will appear in the 
drop-down lists for many fields in the Attribute, Person, Organization, and other data-
entry dialog boxes.

Real-Time Messaging

Log of events handled by the real-time server. The RTS handles the events that 
happen in the EnCompass system, including user logins, messages sent between 
users, and database write events. Whenever a user creates or changes a record, the 
RTS makes the necessary changes in the database and sends the updated information 
to the screens of all connected users. The Real-Time Messaging List presents a 
continuous display of these system events.

Software Defect

Information on features and functions of the EnCompass system software which need 
to be corrected, changed, or added. Members of the engineering team use the 
Software Defect table to communicate with each other about bug fixes and feature 
changes. EnCompass operators and administrators may view the table to see the 
status of a bug fix or feature change request.

Timeslice

Timeslice records contain data on the percentage of time that individual persons 
spend on each of the activities or programs in an activity-based management (ABM) 
project.

Tree Design

Tree designs define which data fields will appear in the EnCompass graphical 2D or 
3D tree display. A tree design consists of a collection of tree view definitions, one for 
each data type.
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User Profile

Login names, passwords, user types, privilege levels, and other information on autho-
rized EnCompass users.

View

Views define what data fields will appear when EnCompass displays a specific data 
type in a data list or the graphical tree display.
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APPENDIX B: LIST OF STANDARD ANALYSES

The following set of basic analyses are to be created for every EnCompass project:

Name Criteria Query DC Query Description

All Very Important 
(agreed)

Importance 1 All Very Important Agreed Importance ±1, else ±5
Freq. >0, Imptc. ≥4, All issues >0

All Frequent Important 
(agreed)

Frequency & 
Importance 1

All Frequent & Impt. Agreed Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0

All Frequent Important 
(disagreed)

" " Disagreed Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0

All Frequent Important 
(either)

" " Either Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0

All Freq Impt Concurrent 
(agreed)

" All Frequent & Impt., 
Concurrent

Agreed Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0, Concurrent

All Freq Impt Concurrent 
(disagreed)

" " Disagreed Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0, Concurrent

All Freq Impt Concurrent 
(either)

" " Either Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0, Concurrent

All Freq Impt Nonconcur-
rent (agreed)

" All Frequent & Impt., 
Nonconcurrent

Agreed Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0, Nonconcurrent



All Freq Impt Nonconcur-
rent (disagreed)

" " Disagreed Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0, Nonconcurrent

All Freq Impt Nonconcur-
rent (either)

" " Either Freq. & Imptc. ±1, else ±5
Freq. & Imptc. ≥3, All issues >0, Nonconcurrent

All Unimportant (agreed) All 5 All Unimportant Agreed All ±5
Freq. >0, Imptc. ≤2, All issues >0

All Frequent Unimportant 
(agreed)

" All Frequent Unimportant Agreed All ±5
Freq. ≥3, Imptc. £2, All issues >0

Issue1 ≥3 : Frequent 
Important (agreed)

Issue1 1, Freq. 
& Imptc. 1

Issue1 ≥3, Frequent 
Important

Agreed Freq. & Imptc. ±1, Issue1 ±1, else ±5
Freq. & Imptc. ≥3, Issue1 ≥3

Issue1 ≥4 : Important 
(agreed)

" Issue1 ≥4,  Important Agreed Freq. & Imptc. ±1, Issue1 ±1, else ±5
Freq. >0, Imptc. ≥3, Issue1 ≥4

Issue1 : Emergence Issue1 1 Issue1 >0, Important Agreed Issue1 ±1, else ±5
Freq. >0, Imptc. ≥3, Issue1 >0

(etc. for all issues)
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